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Installing and Using the Example Programs

Understanding the
Example Programs

Hopper Selected (1-3)
Kiln Speed [ | (0-100%) v \H":/ v

One of the best ways to learn how to use the OP-panel is to load the example
programs which are on the supplied diskette, and run the program for your PLC. A
Cement Kiln System is used to demonstrate the ladder logic required to support the
various OP-panel features. The program provides ladder logic which demonstrates
controlling pushbuttons, lamps, messages and menu operations. Use an
understanding of this example program to help develop programs for your own
applications.

Follow the instructions in this chapter for installing and running the example
programs.

Raw Meal
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Software
Requirements

The example programs require that you have two software packages loaded on your
personal computer:

e Direct SOFT programming software, and
* OP-WINEDIT (OptiMate Editor) configuration software.

If you do not have these software packages, obtain and install them on your personal
computer using the instructions in their user manuals.

Once you have both programs installed on your personal computer you are ready to
use the following step-by-step instructions for installing and using the example
programs.
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Installing and Using the Example Programs

9 Steps to Using the Example Programs

Step 1: Power
Supply Connections

Pushbuttons...

Process Data.....

2 Line x 20 character

L

MENU CLEAI
ABO ENTER

OptiMate_____

An external power supply should be used to power the Optimation unit. The power
supply must supply a voltage of 8 to 30 VDC. Connect the power supply using the
supplied terminal block connector. The connector is keyed to prevent reversing the
polarity. Pin 1 is the positive connection (8 to 30VDC), while pin 2 is the common
(OVDC) or ground connection.

Use 18-24 AWG conductor wire and connect the
power supply to the supplied connector block as
follows: Connect the positive (+8 to 30 VDC) lead to
terminal 1, and connect the common ground (0V)

lead to terminal 2.
Receptacle

Terminal 2

1 2 Cett vaee

Power
Ground m —_ e

Terminal 1 +24VDC ’3%

Plug the terminal block connector
into Power receptacle located on
the back side of the panel.
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Installing and Using the Example Programs

Step 1A:
Multi-Panel Power
Supply
Connections
(Optional)

In multi-panel applications, if using separate power supplies, make sure the
electrical ground commons do not have a great potential difference. When using a
single power supply in a multi-panelapplication, the power supply must maintain the
specified voltage and current consumption for each of the individual units under all
conditions (including power-up). See individual panel power requirements.

’ (Communications to PLC)

Power g% OP-9001
+ Supply f. T -
EJ .
8 to 30 VDC (RS-422) \ ’

L etc...
L ]

e Panel 3

0VDC

Ground
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Installing and Using the Example Programs

Step 2: Setting the
OP-Panel
PGM/RUN DIP
Switch to PGM

Step 3: Selecting
Cables

You may generate your OP-panel configuration off-line. To download your
configuration, the PGM/RUN DIP switch located on the back of the OP-panel must
be set to PGM (ON). The TERM switch should remain off.

NOTE: You must cycle power to the panel (turn power off, set DIP switch, and turn power
back on) to activate the new switch settings.

RUN |1 [ =] PGM —— Setto PGM
2 (wm ] TERM

For multi-panel configurations, see the section titled OP-9001 Multi-Panel
Configurations towards the end of this chapter.

Depending on which PLC you are using, you may require as many as three cables to
use the example programs:

e An OP-ACBL-1 configuration cable to connect your personal computer
to the OP-panel to load the configuration program into the panel. All
panels use the OP—ACBL-1 for the configuration cable. This cable is
also used to connect an OP-panel to an Allen-Bradley SLC 500 CPU.

e A cable to connect your personal computer to the PLC to load the
Direct SOFT example ladder programs into your PLC. See the
Direct SOFT user manual for help in selecting the proper cable to use
with your PLC.

e A cable to connect the OP-panel to the PLC. Use the information on the
next two pages to select the proper cable to use with your PLC.
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Installing and Using the Example Programs

Choosing Your

Connecting Cables

Depending on which PLC you are
using, you may require as many as
two cables. Here are the
requirements:

e  OP-ACBL-1: all units require
this cable for configuration. This
is a 9-pin female to 15-pin male
cable that connects your
personal computer to the
OP-panel. This cable is also
used to connect an OP-panel to
the Allen-Bradley SLC 500
CPUs listed.

e CPUCables: You will also need
the appropriate cable to connect
your CPU to the OP-panel. Use
the chart shown to the right to
choose the correct
communications cable.

OP-9001 Cable Connectors

If you're planning to use multiple
panels and an OP-9001, then you
will need to build your own custom
cables. Since the proper cable
choice really depends on your
application, we offer the following
connectors.

e OP-CMCON-1 — pack of 4
ribbon cable connectors.

e OP-CMCON-2 — pack of 4
solder-type connectors.

e OP-CMCON-3 — pack of 2
D-shell connectors with screw
terminals for use with OP-9001
& multiple OP-panels.

e OP-PSCON — pack of 4 power
supply block connectors.

For electrically noisy environments,
we recommend an individually paired
and shielded cable, such as Belden
9729 or equivalent. This type of
cable requires the solder-type or
D-shell  with  screw  terminal
connectors. For distance of 30 feet or
less, you can use ribbon cable. For
ribbon cable, we recommend
Belden 9L28015 or 3M 3365/15.

*_ requires RS232 Data Communications Unit (D3-232—DCU)

*% .
— also DC versions

OptiMate Cables
e (or oth(e:rp chjevice) pert Gl
Direct LOGIC~ DL130 Only port OP-2CBL
DL105
Direct LOGIC~ DL230 Only port OP-2CBL
DL205 DL240 Top port OP-2CBL
Bottom port OP-2CBL
DL250 Top port OP-2CBL
Bottom port OP-2CBL-1
D2-DCM (module) Only port OP-4CBL-2
Direct LOGIC~ DL330 Requires DCU* OP-4CBL-2
DL305 DL330P Requires DCU* OP-4CBL-2
DL340 Top port OP-3CBL
Bottom port OP-3CBL
DL350 Top port OP-2CBL
Bottom port OP-4CBL-2
Direct LOGIC~ DL430 Top port (15-pin) OP-4CBL-1
DL40S Bottom port (25-pin) OP-4CBL-2
DL440** Top port OP-4CBL-1
Bottom port OP-4CBL-2
DL450 Phone Jack OP-2CBL
Top port (15-pin) OP-4CBL-1
Bottom port (25-pin) OP-4CBL-2
D4-DCM (module) Only port OP-4CBL-2
Slice 1/0 panels Only port OP-4CBL-1
GE" Series 1 1IC610CPU105/106 Requires DCU* OP-4CBL-2
GE" Series~ 90/30 [ All Models (311-351) RS232, RS422 OP-GCBL-1
Serial Port
GE" Fanuc~ All Models RS232, RS422 OP-GCBL-1
Series 90 Micro Serial Port
MODICON ModBus RJ45 port OP-MCBL-1
TI305™ / 325-07, PPX:325-07 Requires DCU* OP-4CBL-2
SIMATICP TI305~ -
330-37, PPX:330-37 Requires DCU* OP-4CBL-2
325S-07 (or 325 w/ Stage Kt) Requires DCU* OP-4CBL-2
330S-37, PPX:330S-37 Requires DCU* OP-4CBL-2
335-37, PPX:335-37 Phone Jacks OP-3CBL
If DCU is used* OP-4CBL-2
TI405~ / 425-CPU, PPX:425-CPU ** Only port OP-4CBL-1
SIMATICP TI405-~ -
PPX:430-CPU Top port (15-pin) OP-4CBL-1
Bottom port (25-pin) OP-4CBL-2
435-CPU, PPX:435-CPU ** Top port (15-pin) OP-4CBL-1
Bottom port (25-pin) OP-4CBL-2
Smart Slice~ 1/0O panels Only port OP-4CBL-1
A-B SLC 500 5/03, 5/04 Bottom port OP-ACBL-1
A-B MicroLogix Only port OP-ACBL-2
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Installing and Using the Example Programs

Connecting Cable Details

Connecting Cable The OP-620 connecting cable may vary depending on which CPU you use. Refer to

the previous page to select the proper cable for connecting to your PLC.

RA:HZ (PLC) D215 oy PLC (glg%%) OP-2CBL OB1S
3— 2 2= not used RJ12 i — 0 =j
1— 5 3= Din —

4= Dout
g: no% useg
= not use
12 3456

RJ11 (PLC) DB15 o OP-3CBL
2——— 3 1= Din DB15
1= 2 7~bout 1 (4P4C —
4 5 if Be/t used ] ) ¢ 0 ]

1234
PBIS(PLC) DBIS 4= yom 1515= tied (0V) OP-4CBL-1
- 7=CTS 14= tied (OV
3 2 - (ov)
4 5  8=notused 13= tied (0V)

13 ‘5; (n)ot Fsed 12=not used A I 0 =
%g 3= D_n- ine 11= not used L= : ! ' =J
1 2= DI(?ut 10= not used
7 1= YOP ] 9= not used DB15 DB15
8

g: no% useg 05 25= not used
= not use 5 24= not used
11=notused |o° 23= not used OP-4CBL-2

DB25(PLC) DBIS  40% otused |55|  22=notused DB25 DB15
% % 8=notused |o° glf not used ] —
7——E 7= 0V . Oznotused |:| Y - . |:| :I
47 6=notused |%o 19= not used — —p
5 5= CTS e © 18= not used

4= RTS ° 2 17= not used
3= Din oo 16= not used
2= Dout 1~ 15=notused
1= not used 14= not used
OP-ACBL-2
L 678 Mini—DIN DB15
8 Pin Mini DIN DB15 3= Di i =j
T s 3on m—
2 5 12 5 =0V
Panel
RS-422 Pinout 1
PLC Panel 9= not used 2 1= not used
D|n + 11 = Dout+ 10: not used ° 2: DOUt
Din — 12 = Dout — 11= not used o| 3=Din
Dout + 9 = Din + 12= not used o gf Bst used
Dout —— 10 = Din— 13= not useg o 6: not used
N 14= not use -
ov 5=0v 15= not used 8 7= not used
RTS+ :I 8= not used
CTS+ 15
RTS-
CTS—:|
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Installing and Using the Example Programs

Step 4: Connecting
Configuration
Cable OP-ACBL-1

Step 5: Installing
the Example
Programs on Your
Personal Computer
Hard Drive

Once the example programs are loaded in your personal computer, the first step will
be to load the configuration program from the computer into the OP-panel, so make
this cable connection first. Connect the configuration cable between the serial port of
the OP-panel and the serial port of the personal computer when configuring panels
using the OP-WINEDIT software. The OP-WINEDIT software requires you to select
the serial port number (com1, com2) being used for configuration. The figure below
shows programming cable connectors and wiring specifications. Wiring diagrams
refer to the cable connectors, not the communication ports.

OP-ACBL-1 (OP-1500 shown, but con-
nections are the same for

Dj] other OP-panels)

Female Male o =
5=0V o 9= not used ) 1= not used
; DB9 DB15 ® | 5 bou
4=notused | O 9=not used 3 3 lo=rnotused | O o ‘

3= Dout 8: crs 2 2 11=notused | O 3= Din

2=Din 7=RTS o 4= not used
° = 5 5 12=notused | O
1=notused | o © 6=not used 7 L 5= 0V
13=notused | O o

1 8— 14=notused | O o 6= not used
Cable Connector 15=notused | O 7= notused
% 8= not used

Cable Connector

It is possible to load the examples from the diskette; however, we recommend
copying themto the hard drive in your computer and keeping the original diskette in a
safe place.

a:\filename.prj

To install the example programs if using Windows 3.1 , follow these steps:

1. Call up the DOS Prompt. Make a new directory on the hard drive in your
computer. For example,
if the hard drive is drive C and you are using an OP-620 panel, type:

MD C:\OP-620

2. Copy all the files from the example program disk to the new directory. For
example, if the diskette is in drive A: and the hard drive is drive C:, type:

COPY A:\*.* C:\OP-620\*.*
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Installing and Using the Example Programs

To install the example programs if using WIN 95 , follow these steps:

1.

2.

Select the Explorer icon and open. If the hard drive is drive C, select the
(C:) icon.

Make a new directory in the hard drive of your computer. For example, if
you are using an OP-620 panel, Select the File menu, then select New and
then Folder. Notice the New Folder icon that appears. Select the folder
and name it “OP-620" by selecting the File menu and selecting Rename.
Type in the new name.

Copy all the contents of the example program disk. Insert the diskette in
drive A, and select and open the 3 1/2 Floppy (A) icon. Notice the disk has
numerous files of example programs. Select all the programs by opening
the Edit menu and selecting Select All . Open the Edit menu again and
select Copy.

Paste the program disk contents into the new C drive “OP—620" directory.
Open the “OP—-620" directory, open the Edit menu and select Paste.

The example programs are now loaded onto the hard drive of your computer.
Remove the diskette from drive A.

Step 6: Loading the The next step is to load the configuration program into the OP-panel as follows:

OP-WINEDIT

Example Program 1.

into the OP—Panel

6.

7.

N

Open the OP-WINEDIT (also called OPEditor) software.
When the initial screen appears, select Existing System .

A File Open window appears. Open the example program file that you just
loaded on your hard drive (“OP-620"). A list of files appears, all having “.ocf”
after the file name. These are all configuration programs.

Select the configuration program for the OP-panel and PLC you are using.
For example, if you are using an OP-620 panel with a DL205 PLC, select
and open the file titled “620_205.ocf".

A screen appears having all the configuration parameters for running the
example program using an OP-620 with a DL205 PLC. Make sure your
OP-ACBL-1 cable is connected between your personal computer and the
OP-panel, that the DIP switch slides are set to ON, and that the OP-panel
power supply is on. Select Configure Panel.

When the next window appears, select Write to Panel . This loads the
program into the OP-panel.

After the program is loaded, close the open windows and select Exit
Software . This closes out the OP-WINEDIT software.

The OP-panel is now configured, and the OP-ACBL-1 cable can be disconnected.
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Installing and Using the Example Programs

Step 7: Setting the  To run the example programs, set the RUN/PRG DIP switch to RUN.

OP-Panel PRG/RUN
DIP Switch to RUN

NOTE: You must cycle power to the panel (turn power off, set DIP switch, and turn
power back on) to activate new switch settings.

Set to RUN

ON
RUN |1 [mm ] PGM
2 (mm ] TERM

Step 8: Loading the The next step is to load the DirectSOFT example program into the PLC as follows:

Direct SOFT

Example Program 1.

into the PLC

w

Connect the communications cable from your personal computer
communications port to your PLC’s programming port on the CPU.

Start Direct SOFT on your personal computer.
Select Open Document.

A dialog box appears. Open the example program file that you just loaded
on your hard drive ("OP-620"). A list of files appears, all having “.prj” after
the file name. These are the example program files. Notice that the
program files are named for the OP-panel and PLC being used and end
with “.prj”.

Select the example program for the OP-panel and PLC you are using. For
example, if you are using an OP-620 panel with a DL205 PLC, select and
openthefileftitled “620_205.prj”. When the program opens, its ladder rungs
will appear on the monitor screen.

Select the PLC menu, then Connect , then select the link to use. All the
program examples are saved without PLC link information, so you have to
re-connect to your particular CPU. If a message appears which asks you to
select the source of program to view, select Disk.

Make sure the CPU is in Program mode. Then download the program to the
CPU. One method is to select the File menu, Write Program ..., then select
To PLC.

When the program download is complete, putthe CPU in Run Mode. Select
the PLC menu, PLC Modes ..., then select Run. The program is now
running.

Step 9: Connecting  The next step is to connect the OP-panel to the PLC using the cable you selected

the OP-Panel to the earlier. Once the OP-panelis connected to the PLC you can run the program. Read

PLC and Running through the following section, Running The OP-620 Example Program, while at the

the Program same time doing the setup and actually running the program on your OP-panel. It
would be helpful to print a hardcopy of the example program and study the ladder
logic to see how the program operates. In addition, see the Kiln Demo Worksheets at
the end of this chapter to help understand the program. There are also blank
worksheets to use for your own applications.
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Installing and Using the Example Programs

Running the In this example program a Cement Kiln System is used to demonstrate the ladder
OP-620 Example logic required to support the various OP-panel features. The program provides
Program ladder logic which demonstrates controlling pushbuttons, lamps, messages and

menu operations.

Items listed in the figure below, such as Hopper Selection, Kiln Speed,
Start/Stop/Run controls, and Kiln Zone Temperatures are monitored and controlled
by the OP-panel example program.

Raw Meal

Hopper Selected

(1-3)
Kin Speed [ | (0-100%) v \HO:/ t/

| N\\\\\NI|

<—— Flow

Cement Kiln
- rK\Wh_ 1 :®:_ 1 rK/Dh_ -
Zone 1 Zone 2 Zone 3
Temperature Temperature Temperature

b )

) et )
& e O = .

There are two parts to the program: 1. Using the “MENU” function to enter the setup
parameters, and 2. Starting and stopping the program. We will discuss setup first.

Use your imagination to picture the operation of the kiln system shown. The first
thing we must do is the program setup. There are two main categories of setup
parameters, “Raw Meal Control” and “Temperature Control”. We will discuss “Raw
Meal Control” first.

There are two parameters which must be setup for “Raw Meal Control™:

* “Hopper Selection”: This parameter selects which hopper is going to
provide the material for the kiln system. The choices are Hopper 1,
Hopper 2 or Hopper 3.

e “Kiln Speed”: This parameter selects the speed that the material will
travel through the kiln system. The speed is specified as a percentage
of the maximum possible speed and can be set for any speed between
1% (lowest speed) and 100% (highest speed).
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Installing and Using the Example Programs

2 Line x 20 character
CLEAR/
@ @

NINNNN

OptiMare____
\
\
Indicator Light F1 F2 F3 F4 F5

There are three parameters which must be setup for “Temperature Control”:

“Setpoint Zonel Temp.”: This parameter selects the temperature that
the material will be exposed to while traveling through Temperature
Zone 1. The temperature can be set to any setting from 1 to 2,000, with
1 being the lowest temperature setting and 2,000 being the highest.

“Setpoint Zone2 Temp.”: This parameter selects the temperature that
the material will be exposed to while traveling through Temperature
Zone 2 and can be set from 1 to 2,000.

“Setpoint Zone3 Temp.”: This parameter selects the temperature that
the material will be exposed to while traveling through Temperature
Zone 3 and can be set from 1 to 2,000.

Once all five parameters are setup, we are ready to run the program. This is done by
pressing the F1 pushbutton. To stop the program, press F2.

This is a simple program, but it shows how a program can be developed for a
practical application for the OP-panel. Follow these step-by-step directions to setup
the parameters and run the example program:

1. After starting the Direct Soft example program, the initial OP-panel display

IS:

OP-620 KILN DEMO
MENU: Setup F1: Start

The first thing we want to do is setup the parameters, so press the Menu
pushbutton to get the following screen:

Raw Meal Control
Enter/Arrow/Clear
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Installing and Using the Example Programs

Press either of the up/down arrow pushbuttons (Aor'V) to get the following
screen:

Temperature Control
Enter/Arrow/Clear

Notice that pressing either AW pushbutton toggles the display between
these two screens. These are the two main categories of setup
parameters. In the second line of each screen are three choices of
pushbutton selections we can make at this point:

e Enter: Press this to setup the parameter currently shown.

e Arrow: Press either AV pushbutton to toggle between the two
screens.

e Clear/Abort: Press this pushbutton to return to the initial screen.

Let’s setup the Raw Meal Control first, so press either A'Y pushbutton to
get to that screen, and press Enter. The following screen appears:

Hopper Selection
Enter/Arrow/Clear

Press Enter. The following screen appears:

Meal Hopper (1-3): 2
Arrow UP/DOWN =1

Select Hopper 1, 2 or 3 by using the AV pushbuttons, and pressing Enter.
For example, the “2" on the top line indicates that Hopper 2 is currently
selected. If we wish to change our selection to Hopper 1, press AV
pushbuttons until a “1” is displayed on the bottom line, and press Enter. A
“1” replaces the “2” on the top line and the display returns to the previous
“Hopper Selection” screen.

Pressing Clear/Abort cancels any changes made and returns the display
to the initial screen.

Next we need to set the kiln speed. With the “Hopper Selection” screen
displayed, press AV pushbuttons to get the following screen:

Kiln Speed Control
Enter/Arrow/Clear

Page A-13



Installing and Using the Example Programs

4. Press Enter. The following screen appears:

Kiln Speed (%) : 25
New Kiln Speed = 50

Select kiln speed by using the AV pushbuttons, and pressing Enter. For
example, the “25” on the top line indicates that a speed of 25% of maximum
speed is currently selected. If we wish to change our selection to 50% of
maximum speed, press the A pushbutton until a “50” is displayed on the
bottom line, and press Enter. A “50” replaces the “25” on the top line and the
display returns to the previous “Kiln Speed Control” screen.

Both Raw Meal Control parameters are now set. Next we need to set the
three Temperature Control parameters.

5. Press Menu and use the AV pushbuttons to select the following
Temperature Control screen:

Temperature Control
Enter/Arrow/Clear

Press Enter to get the following screen:

Setpoint Zonel Temp.
Enter/Arrow/Clear

First we will set the Zone 1 temperature. Press Enter to get the following
screen:

Zonel Temp. SP: 100
Enter New Temp= 200

Select Zonel temperature by using the AV pushbuttons, and pressing
Enter. For example, the “100” on the top line indicates the current Zonel
temperature setting. If we wish to change our selection to “200”, press the
A pushbutton until a “200” is displayed on the bottom line, and press
Enter. A“200” replaces the “100” on the top line. The Zonel temperature is
now set and the display returns to the following screen:

Setpoint Zonel Temp.
Enter/Arrow/Clear
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6. We now need to set the Zone 2 and Zone 3 temperatures in the same
manner. To set the Zone 2 temperature, press the AV pushbuttons until
the “Zonel” portion of the display changes to “Zone2” as follows:

Setpoint Zone2 Temp.
Enter/Arrow/Clear

Press Enter, and set the Zone 2 temperature the same way that you set the
Zone 1 temperature. Repeat the same procedure for the Zone 3
temperature.

All setup parameters are now set, and you are ready to run the program.

7. Afterthe last setup parameter is entered, press Clear/Abort toreturntothe
following initial screen:

OP-620 KILN DEMO
MENU: Setup F1: Start

To start the program, press the F1 pushbutton. Notice that the F1 indicator
light momentarily lights and the screen quickly changes to the following:

KILN STARTING
Press F2 to Stop
The above screen only appears momentarily before changing to the
following:
SYSTEM RUNNING
Press F2 to Stop

The program is now running using the parameters we preset. If you wish to
stop the program, press F2. The program stops, the F2 indicator light goes
on, and following screen appears:

KILN SYSTEM STOPPED

Press F2 to Continue

Press F2 to resume running the program. You have now run through the
entire example program.

Print a hardcopy of the example program and study the ladder logic to see how the
program operates. Hopefully this example will help you utilize the OP-panel for your
own applications.
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KILN DEMO EXAMPLE WORKSHEET PAGE:
PUSHBUTTONS / LAMPS :
DESCRIPTION . _OP-620 Kiln Demo A M (Alternate/Momentary)

F1 [][x] _Start

System Type

Panel Type OP-620 F2 ®[] _Stop
PLC Base Register Addr
F3 10
PLC CONFIGURATION : F4 00O
PLC Family F5
CPU Model 0o
Protocol Green _
PLC Address Lampl | System Running
PLC Timout
Yellow .
Baud Rate Lamp?2 | _ System Starting
Parity Rod
Data/Stop Bits Lamp3 | _ System Stopped
MESSAGE:
Text
No-1 1oflp|l-|6f2]0 k[ i1|L|nN] |DlE[M]O
Action: N/A Data Type/Format:  N/A Range: N/A
Text Message
No. 2 Ml EIN| Ul :| S| E|] T|U| P FI1) :| S| T| A|R|T
Action: N/A Data Type/Format:  N/A Range: N/A

Text Message
No.3 |kl |L]|N s|TlA|lR|T|I|N|G

Action: N/A Data Type/Format:  N/A Range: N/A
Text Message
No.4 | plR|E|S]S Fl 2 T|O s|T|o|P
Action: N/A Data Type/Format: N/A Range: N/A
Text Message
No.5 |s|vy|s|[T|E|M RI|U|IN|N[I[N]G
Action: N/A Data Type/Format:  N/A Range: N/A
Text Message
No.6 |p|R|E|S]|S F| 2 T|oO s|{T|ofP
Action: N/A Data Type/Format: N/A Range: N/A
Text Message
No.7 | k| I|L|N s|Y|[s|T|E|M s|T|o|lP|P| E|D
Action: N/A Data Type/Format: N/A Range: N/A
Text Message
No. 8 PIR| E[S]|s F| 2 T|oO clo|N|[T|I|N|U|E
Action: N/A Data Type/Format:  N/A Range: N/A
Text Message
No.9 | m| E| A| L Hl ol PIP|E|R| |(|1]-]|3])]|: A
Action: N/A Data Type/Format: INTEGER/BCD Range:
Text Message
No.10 | A| R| R| O] W ulp| 7| D| ol w|N = ~lA] A
Action: Arrow Data Type/Format: BCD Range: 1-3

Page A-16




Installing and Using the Example Programs

EXAMPLE MESSAGE WORKSHEET PAGE:
MESSAGE:
Text Text Message
NO-11 | e L] N s| plE|E| D (w1~ ]~ |~ |
Act on_:l_ l;l({A cen Data Type/Format: BCD Range: N/A
No.12 f Nf Elw| |k 1| L|N s|PlE|E|D =
Action:  Keypad Data Type/Format: BCD Range: N/A
No.13 |zl o|N|E |1 TIE[M|P| |S|P]:]|~]|*]| |
Action: N/A Data Type/Format: BCD Range: N/A
No.14 | gl N|T|E (R N[E[wW| [TlE[MP].][=]r]|r [~ ]n
Action:  Keypad Data Type/Format:  gcp Range: N/A
No.15 | 7zl o|N|E |2 T|E|M|P s|pl:[r[r]|r |~
Action: N/A Data Type/Format: gcp Range: N/A
Nol6 | e[ N[T|E|R NIE|w| [T]E|MP[.[=]|*] ||
Action: Keypad Data Type/Format: BCD Range:  n/A
No.l7 1 zlo|N |E |3 T|E|M|P s|pl:[~[r | |
Action: N/A Data Type/Format: BCD Range: N/A
No.18 | gf N[ T|E|R NI E|w| [T]E[MP[.[=][~]r]|"]
Action: K evnad Data Type/Format: gcp Range: /A
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
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Installing and Using the Example Programs

EXAMPLE MENU WORKSHEET PAGE:
MENU:
Text

No. 1 RIA|lW MIE|A|L clo|N|T|[R|O|L
Menu Level 2| 3| 4| Function No.| -

No. 2 HIO[P|P|E|[R S|E|L|E|C|T Il O|N
Menu Level 3| 4| Function No.| 1

No. 3 KIT]L|N S| PIE|E|D C|OIN|T| RIO| L
Menu Level| 1 3| 4| Function No.| 2

No. 4 TIEIM|P|EIR|A|T|U|R]|E C|OIN|T|R|O|L
Menu Level 2| 3| 4| Function No.

No. 5 S|EIT|P|O|I|N|T Z|O| N|JE| 1 T|E[M| P
Menu Level| 1 3| 4| Function No.| 3

No. 6 S|EIT|P|O| I|N|IT ZIO| N|E| 2 T|E[M| P
Menu Level| 1 3| 4| Function No.| 4

No. 7 S|E|T|[P|O|I|N|T z|o|N|E| 3 T|E|M|P
MenuLevel| 1 3| 4| Function No.| 5

No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Level| 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
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Installing and Using the Example Programs

OP-620 APPLICATION WORKSHEET PAGE:
PUSHBUTTONS / LAMPS :
DESCRIPTION - A M (Alternate/Momentary)
System Type F1 00
Panel Type F2 [0
PLC Base Register Addr
F3 1]
PLC CONFIGURATION : F4 0
PLC Famil
CPU Mode)ll ~ o
Protocol Green
PLC Address Lampl
PLC Timout Yellow
Baud Rate Lamp2
Parity Red
Data/Stop Bits Lamp3
MESSAGE:
Text Message
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
No.
Action: Data Type/Format: Range:
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OP-620 MESSAGE WORKSHEET PAGE:

MESSAGE:

Text Message
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
No.

Action: Data Type/Format: Range:
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OP-620 MENU WORKSHEET PAGE:

MENU:
Text Message

No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Level]l 1| 2| 3| 4| Function No.
No.

Menu Levell 1| 2| 3| 4| Function No.
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OP-9001 Multi-Panel Configurations

The Termination
Resistor

If you are connecting more than one OptiMate panel to a single CPU this is referred
to as multi-panel configuration. Multi-panel configurations require the OP-9001
Communications Master, which the CPU communicates to for obtaining data from
the connected OP-panels. The OP-9001 Communications Master looks for an
address within the range of 0 to 30 for each panel connected. Each panel connected
ina RS-422 link must have a unique address. A more detailed description of multiple
panel configuration and installation is given in the OP—9001-M User Manual.

The last panel must be terminated when using a RS-422 communications link by
setting DIP switch 2 to the TERM (ON) position. Operator panels communicatiing
more than 50 feet distance must use RS-422 and also be properly terminated.

NOTE: Only the last panel of each RS-422 link should have the termination DIP
switch 2 set to the TERM position. All other panels should have the DIP switch set to
the off (left) position. After changing the DIP switch settings, remember to cycle
power on panel to activate the new switch settings.
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